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I. 培训目的 
 

本教材是为不熟悉 UNICORN™ 6 软件和 ÄKTApure 新装机用户培训而编

写，您可以在本教材中学到 UNICORN 6 控制软件的基础知识以及如何通过

UNICORN 6来控制 ÄKTApure系统。 

 

通过本次培训您将掌握以下方面的内容： 

 

 掌握 ÄKTApure的硬件操作，包括开机、关机及系统维护 

 

 通过手动命令完成层析实验 

 

 通过方法编辑设置自动运行的程序 

 

 基本的结果处理 

 

II. 培训准备 
 

 仪器设备: ÄKTApure设备以及安装有 UNICORN 6的电脑 

 

 缓冲液准备：在培训中用到的各种溶液都要经过 0.22 µm滤膜过滤，

且通过真空抽滤或超声（至少 15 min ）除去气泡 

 

 样品准备：经 0.22 µm 针头滤器过滤以去除颗粒性物质 

 

III. 培训内容 

1. 新装 Unicorn软件的基本设置 

 

1.1 系统设置 

新安装 UNICORN 6 软件后，需要根据 ÄKTApure 的硬件配置在软件中将

相应的硬件选择或去除。在 Administration窗口中点击 System Properties 
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选中已连接的系统，并点击下侧 Edit按钮 

 

 
 

在跳出的编辑对话框左侧选择组件类型 “Component types”，根据

ÄKTApure 的硬件配置，在右侧选定相应的组件，然后点击 OK 即可使

UNICORN 6 软件识别 ÄKTApure 相应的硬件。在硬件升级需要添加组件或者

需要减少硬件组件时也需要在此处进行设置。 
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1.2 新建用户及权限设置 

1.2.1新建用户 

 

在 Administration 窗口中选择 UNICORN User Setup 

 

 
 

在跳出的对话框中选择 New，在右侧 User Properties一栏中输入用户名、

职位、E-mail，为该用户选择所属的用户组，点击 OK 创建该用户。软件向

注册的 E-mail发送注册信，确认后即可成功新建用户。 
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1.2.2设置用户权限 

 

1) 点击 Administration 窗口中 Access Groups and Network Users，在弹

出的窗口中可以设置各用户组的权限或新建用户组 

 

2) 在 Access Groups 中选中要编辑的用户组名称，在右侧指定该用户组

能够打开的操作窗口、能够控制的硬件设备以及文件存储位置，点击

OK保存设置 

 

 
 

1.3 系统默认参数设置 

为了方便使用，系统的操作和检测参数已经进行了默认设置，一般情况

下不需修改；如果需要对系统默认参数进行修改，可以进入 System Control

窗口，在 System 下拉菜单中选择 Settings 
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在弹出的对话框中设置各种开机默认参数，譬如报警参数以及检测器参

数。如果更换了系统标配的管线，需要重新测量检测器之后的延迟体积，并

把这个体积输入到 Delay volume输入框中，点击 OK保存并退出 

 

 
 

1.4 校正 

如果需要对各种检测器（pH、电导、压力）进行校正，请在 System 

Control窗口中的 System下拉菜单中选择 Calibrate  
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1) 如果需要校正 pH探头，在 Monitor to calibrate下拉框中选择 pH，点

击下边的 Prepare for calibration并在 pH for buffer 1一栏中输入标准

液 1的 pH值 

 

 
 

使用注射器向 pH阀中注入约 10 ml pH标准液 1，待 Current value读

数稳定后点击 Calibrate，然后向 pH阀中注入去离子水对其进行清洗 

 

在 pH for buffer 2一栏中输入标准液 2的 pH值，使用注射器向 pH阀

中注入约 10 ml pH 标准液 2，待 Current value 读数稳定后点击

Calibrate 
 

slope 和 asymmetry 反应了电极的状态，如果 slope > 80% 且

asymmetry 在 ± 60 mV范围内，则电极状态良好，否则需要对电极进

行清洗或更换 

 

2) 如果发现层析系统的压力检测不准确（譬如在没有流速的情况下仍然

显示有一定的压力），需要对压力感受器进行校正，在 Monitor to 

calibrate下拉框中选择 System pressure  
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将泵头抽气旋钮拧松，确保压力感受器不受任何压力 

 

 

 

点击 Reset pressure对压力进行归零 
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2. UNICORN软件的使用 

2.1 开机 

1) 先打开 ÄKTApure电源，当控制面板上的 Power灯稳定不再闪烁时打

开电脑，双击电脑桌面上的 UNICORN 6图标打开软件 

 

 
 

2) 选择用户，输入密码（如果进行了设置），点击 OK进入软件 

 

 
 
 

3) 在任务栏中将出现四个软件窗口，单击系统控制 （System Control） 

   

 
 

如果 System Control窗口没有自动弹出，可在任意打开的窗口中点击

Tools > System Control打开 
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4) 进入 System Control窗口，点击 Connect to Systems，在弹出的对话

框中选中已连接的系统名称，点击 OK确认连接 

 

 
 

2.2 实验前的准备 

2.2.1缓冲液准备 

所有层析用的缓冲液及样品都需要用 0.22 µm 的滤膜过滤，并对缓冲液

进行脱气处理（如超声波脱气或者负压脱气） 

 

2.2.2泵头抽气 

如果缓冲液进口管是空的或者有太多气泡，此时需要手动排气。在泵头

上方的抽气螺母上连接一个注射器，拧松螺母并抽气。泵头内的气泡也是导

致压力和流速不稳定的主要原因，也需要采用这种方式来排除泵头内的气泡 
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2.2.3泵冲洗 

1) 将进口管转移到缓冲液中：将缓冲液进口管从 20%乙醇保护液中转

移到相应的缓冲液瓶中。如果是凝胶过滤通常只需要使用一种缓冲液，

而亲和层析、离子交换等吸附性层析则通常需要两种或更多的缓冲液。

如果缓冲液含高盐，建议先将进口管转移到去离子水中进行泵冲洗，

然后再转移到相应缓冲液瓶中再进行泵冲洗 

 

 
 

2) 在 System Control 界面的 Manual 下拉菜单中选择 Execute Manual 

Instructions 
 

 
 

3) 在跳出的 Manual instructions窗口中，选择 Pumps > Pump A wash，

选择需要冲洗的缓冲液入口， 点击 Execute，进行泵的自动冲洗 
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2.2.4安装柱子 

1) 在 Flow path命令组中选择 Column position , 在 Position下拉框中选

择柱子需要连接的位置,  在 Flow Direction 复选框中选择溶液流向，

点击 Insert 

 

 
 

2) 在 Pumps命令组中选择 System flow, 在 Flow rate一栏中输入一个较

小的流速如 0.5- 1 ml/min, 点击 Insert 

 

 
 

3) 在 Alarms命令组中选择 Alarm pre column pressure, 根据所使用柱子

的耐受压设置 High alarm，如 0.3 MPa，点击 Insert。 点击 Execute

后将执行插入的所有命令 
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4) 在柱位阀的相应位置上连接一根 PEEK 管，待 PEEK 管的出口有持续

液体流出时，除去层析柱的上堵头，将层析柱柱头与连接管出口相连，

但不要拧紧，因为此时出口尚未打开 

 

 
 

5) 除去层析柱下堵头，并将层析柱出口连接到柱位阀的相应位置上，然

后拧紧上接头 

 

 
 

6) 点击 end，完成准备工作 
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2.3 采用手动命令进行层析实验操作 

2.3.1平衡 

1) 为了完整保存手动命令运行结果，在 Manual instruction 界面中选择

Save result as后的 Browse按钮 

 

 
 

选择保存的路径，输入结果文件名，点击 OK即可 
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2) 检查缓冲液入口是否在合适的溶液中，在 Alarm pre column pressure

命令输入框中输入高压报警值，譬如 0.3 MPa，点击 Insert插入命令 

 

 
 

3) 在 Pumps命令组中的 System flow命令的输入框中输入层析柱的平衡

流速，点击 Insert 

 

 
 

4) 在 Flow path命令组中的 Column position下选择层析柱位置及液流方

向，点击 Insert插入命令  

     

 
 

5) 如果检测器默认的三个检测波长不是自己需要的，可进入 Monitors

命令组在 Wavelength 命令的输入框中输入您需要的波长，并且可以
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通过选定 UV2 和 UV3 后面的 Off 复选框来关闭这两个波长，点击

Insert插入命令 

 

 
 

6) 点击 Execute执行所有插入的命令，系统开始对层析柱进行平衡 

 

 
 

7) 在层析柱平衡完成时，上样前通常还会做一个紫外调零的动作。在

Monitors命令组中选择 Auto zero UV，点击 Execute执行 
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2.3.2 上样 

根据上样体积的大小，可以有 3种上样方式: 

2.3.2.1使用样品环上样（上样体积 5ml以内） 

1) 将合适的样品环连接于上样阀的 LoopF 与 LoopE 口上，用注射器抽

取平衡缓冲液，从 Syr上样口推入，冲洗样品环 

 

 
 

2) 用注射器吸取稍大于样品环体积的样品，将注射器内的样品从 Syr 口

推入，注意不要将气泡推入样品环 

 

 
 

3) 在 Flow path命令组中的 Injection valve中选择 Inject，按 Execute执

行 
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4) 待上样完成后（完全上样通常需 2倍以上样品环容积的缓冲液流过），

将上样阀状态切换为 Manual load，点击 Execute执行，完成上样 

 

 
 

2.3.2.2使用 Superloop上样（适合上样体积 1 ml至 150 ml） 

1) 将 Superloop 连接于上样阀上，注意 Superloop 的上端连接到上样阀

的 LoopE位置，下端连接到 LoopF位置 

 

2) 从 Syr 口打入样品，将样品阀状态改为 Inject 开始上样，通过

Superloop 上的刻度计算上样体积，当 Superloop 内的活塞达到预定

刻度时，将样品阀的位置改为 Manual load，完成上样 

 

2.3.2.3用系统泵上样（适合上样体积大于 100 ml） 

1) 首先使用平衡缓冲液泵洗 A2 入口，然后将 A2 缓冲液进口管放入样

品中，确保进口管中没有气泡，在 Flow path命令组中的 Inlet A命令

中选择 A2点击 Insert  
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2) 插入 Flow path命令组中的 Injection mark，点击 Execute执行，样品

就会由 A2进口管进入层析柱 

 

 
 

3) 达到预计的样品体积时，将 A泵进口管再更改为 A1，就完成了上样 

 

 
 

2.3.3设置组分的收集方式 

组分的收集可以采用组分收集器收集，也可以采用出口阀收集。采用组

分收集器收集可以分为固定体积收集和按峰收集 
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2.3.3.1固定体积收集 

1) 在 Flow path 命令组中将出口阀 Outlet valve 的位置由 Waste 改为

Frac 
 

 
 

2) 在 Fraction collection 命令组中的手动收集命令 Fractionation 中设置

每管收集的体积（或时间）Fraction size，点击 Execute执行 

 

 
 

当收集的样品还没有达到设定的体积，而需要换到下一管时，可以执

行 Feed tube命令进行跳管 

 

 
 

3) 当需要停止收集时，执行 Stop fractionation命令或者在 Fraction size

中输入 0，点击 Execute执行 
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2.3.3.2按峰收集 

1) 首先需要设定峰的判断标准，在 Peak fractionation parameters 命令

中选择 Signal source 为 UV1（或者其它），Mode 选择为 Level（或

者 slope），在 Start level 输入框中输入峰的判断标准，一旦紫外吸

收值达到设定值就会触发组分收集器进行收集 

 

 
 

2) 在 Peak fractionation 命令中输入 Fraction size，点击 Insert，后点击

Execute执行 

 

 
 

3) 需要停止峰收集的时候执行 Stop peak fractionation 

 
 

juanjuanzhang

juanjuanzhang
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4) 如果希望按照外接检测器（譬如视差检测器）的吸收峰来进行峰收集，

在选择判断峰的标准时需要选择 Fraction collection > Peak 

fractionation parameters > Signal source > Analog in 1, 在 Start level中

输入临界电压值来启动峰收集 

 

 
 

2.3.3.3使用出口阀进行大体积收集 

 

除了 Frac 和 Waste 位置外，出口阀 V9-O 还有 10 个出口，都可以用来

进行不同组分的大体积收集。在 Fraction collection > Fractionation in outlet 

valve 命令中选择 Start position，并输入收集的组分数以及每个组分的收集

体积，点击 Execute执行 

 

 
 

2.3.4洗脱 

对于吸附性层析往往需要改变洗脱液的洗脱强度来实现分离，这就需要

在洗脱时 A、B 泵相互配合来实现。在 Pumps 命令组中的 Gradient 中输入

目标洗脱缓冲液的比例，如果是阶段梯度洗脱在 Length中输入 0 min，B的

比例立即达到设定值；如果需要线性梯度洗脱，在 Length 中输入时间，洗

脱液将会在设定的时间内逐渐达到设定的比例 
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2.3.5其他命令 

2.3.5.1关于手动命令中的一些其他命令 

1) Monitors > Relative scale cond 命令中 Conductivity value 0%和

Conductivity value 100%: 在离子交换中将平衡液的电导率值输入到

Conductivity value 0%的输入框中，将洗脱液的电导率值输入到

Conductivity value 100%的输入框中，这样就可以根据 Cond%曲线所

显示的数值来判断那一时刻从层析柱流出的液体中洗脱液所占的比例 

 

 
 

2) Watch Parameters 这一设置的前提是在方法编程中使用了

Conductivity less than或者 Stable pH这类功能做为触发下一操作点的

判断标准 
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3) 在层析实验过程中随时可以根据需要使用 Other > Set mark命令在图

谱中添加标记 

 

 
 

4) 如果希望系统过一段时间或者体积后能自动暂停或停止，可以使用

Other > Timer命令，选择判断标准为时间或者体积，在输入框中输入

数值，选择后续的操作为 Pause或 End，点击 Execute执行 

 

 
 

2.3.5.2工具栏中的命令 

1) 在层析实验过程中可以通过点击工具栏中的 Pause按钮让系统暂停 
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点击 Continue，继续 

 

 
 

2) Hold 只有在运行自动程序时起作用，点击 Hold，系统将维持现有状

态运行，直至点击 Continue后继续运行后续程序 

 

 
 

3) 系统控制窗口有四个窗格组成，窗格的相对大小可以通过拖动边界线

来实现，并且可以有选择的显示窗格 

 

 
 

4) 如果需要断开该 ÄKTA与计算机之间的连接可以点击断开连接按钮 
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2.3.5.3系统属性选项卡 

1) 点击工具栏中的属性按钮 

 

 
 

2) 启动属性选项卡，在曲线选项卡中可以调整在曲线窗口中显示的曲线 

 

 
 

3) 在曲线类型和颜色选项卡中选择用哪种颜色和类型的曲线标志哪一个

参数 
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4) 在 X 轴选项卡中设置 X 轴是以体积还是时间为显示单位以及固定 X

轴显示范围还是可变 X轴范围 

 

 
 

5) 在 Y轴选项卡中可以设置 Y轴的显示哪一数据以及显示范围 
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2.3.5.4右键工具 

1) 在层析过程中，我们可以随时通过框选图谱的某一部分放大图谱，以

便观看，如果需要恢复到原来的状态，可以点击右键后在悬浮框中选

择 Undo Zoom或者 Reset Zoom           

  

 
 

2) 如果需要查看曲线上的某一点的坐标值，可以右键点击后选择

Vertical Marker，图谱中将会出现一条垂直的 Marker，鼠标按住 Mark

进行拖动，在显示框中显示的就是曲线上点的坐标值，鼠标点击曲线

窗口上部的图例，Marker就会显示相应曲线上的坐标            

 

 
 
 

3) 右键点击并选择 Copy to Cliboard可以将现有图谱拷贝到剪切板上，

进而可以粘贴到 word等文档中 
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2.4 方法编辑 

1) 在任务栏中点击进入 Method Editor窗口 

 

 
 

如果任务栏中没有 Method Editor 窗口，可以在任意已打开的

UNICORN 6窗口中点击 Tools，选择 Method Editor打开 

 

 
 

2) 在工具栏中点击 Create a new method，启动方法编程 
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3) 在 Predefined Method下拉框中选择层析实验的类型 Cation Exchange 

Chromatography (CIEX)，根据原理还包括：亲和层析、阴离子交换、

疏水、反相以及凝胶过滤等 

 

 
 

4) 点击 OK，方法编辑界面中出现预设的 CIEX层析实验各个阶段及参数 

 

 
 

如需添加新的实验阶段，可以从 Predefined Phases 中选中目的操作

并拖动到编辑窗口中适当的位置处 
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5) 在 Method Settings编辑界面中，选择实验所用的层析柱 HiTrap SP FF, 

1 ml 
 

 
 

6) 如果在列表中没有您所要使用的柱子，或者您使用的是自行装填的柱

子，您可以选择 Any；或者将层析柱的信息先输入到系统中去，输入

层析柱信息需要在任意 UNICORN 6窗口中选择 Column Handling  

           

 
 

在弹出的柱列表中，点击 New新建一个信息 
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输入层析技术、体积单位、压力、流速、柱高、内径等需要强制输入

的内容以及其他可选输入信息后点击 Save as，输入名称后点击 OK

保存 

 
 

这样在 Column列表中就有了所建立的柱子信息 

 

 
 

7) 选择柱子连接到柱位阀上的位置以及缓冲液入口 
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对于选择的预装柱，系统会预设好默认流速，也可以在一定范围内进

行修改 

 

8) 选择检测的 UV波长以及是否激活 pH检测器、A B缓冲液入口的气泡

检测器 

 

 
 

9) 点击 Equilibration 进入平衡阶段设置，输入平衡时缓冲液 B 所占的比

例（默认为 0%，有时为了减少非特异性吸附可以用一定比例的 B 缓

冲液来平衡），输入平衡体积 

 

 
 

如果需要监测平衡，还需要输入达到平衡时的判断条件，所设条件得

到满足后即结束平衡进入下一实验阶段 
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10) 点击 Sample Application 进入上样阶段设置，选择上样的方式，如果

是采用手动上样（样品环或者 Super loop），请输入清空样品环的体

积（该体积如果比样品环的容积小，则输入的体积就是上样体积，如

果输入的体积大于样品环的体积，则上样体积为样品环的容积） 

 

 
 

11) 如果选择系统泵直接上样，需要选择样品入口，输入上样体积、上样

流速，选择是否使用默认进口中的缓冲液冲洗上样流路以及上样后是

否使用默认进口中的缓冲液将样品完全冲进去 
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12) 对于流穿峰可以选择收集或者不收集，如果选择收集可以选择用出口

阀收集或者用组分收集器收集。点击 using outlet valve，选择 Fixed 

volume fractionation，选择出口阀起始位置，输入每管收集的体积 

 

 
 

如果选择峰收集，需要首先定义峰的参数，可以选择以紫外的吸收值

或斜率来判断峰，输入吸收值或斜率，再输入每管收集的体积即可 

 

 
 

如果选择用组分收集器收集，除了可以设置固定体积收集或峰收集外，

还可以选择二者结合，在没有出峰的时候，可以设置较大的收集体积，

出峰后改为精细收集 
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13) 点击 Column Wash 进入柱冲洗阶段设置，选择冲洗使用 B 液浓度

（默认为 0%）以及冲洗的溶液体积，也可以选择监视冲洗的再平衡

状态 

 

 
 

冲洗液也可以选择是否收集以及收集的方式 

 

 
 

14) 点击 Elution 进入洗脱设置，首先选择洗脱的流速、缓冲液入口以及

缓冲液流向 
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洗脱方式有两种，Isocratic elution洗脱方式只使用一种缓冲液洗脱，

通常用于凝胶过滤层析。设置收集体积为 1.5 CV，使用 0% B液，使

用 Fraction collector进行峰收集（也可以如前所述进行自由设置），

可以通过勾选 Start fractionation after 0.3 CV从洗脱开始过三分之一

个柱床体积后才开始收集 

 

 
 

线性梯度的洗脱方式适用于各种吸附性层析的洗脱条件摸索 。使用

线性梯度方式洗脱，需要输入开始及结束时缓冲液 B的比例以及在多

少个柱床体积内 B逐渐达到目标 

 

 
 

通过点击 Add Segment 可以设置更复杂的多步洗脱，首先在 Type 一

栏中选择 Step，输入 Target %B为 20以及 Length 5 CV进行第一步

阶段洗脱 
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点击 Add Segment 添加洗脱步骤，在 Type 一栏中选择 Linear，输入

Target %B为 100以及 Length 20 CV，设置第二步线性洗脱 

 

 
 

最终的洗脱方式如下图所示 

 

 
 

收集方式与之前的设置方法相同，可以进行自由选择 
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15) 点击 Column Wash 进入柱冲洗阶段设置，此阶段目的是对层析柱进

行再生。设置再生时缓冲液的流速、进口、洗脱体积，也可以设置监

视平衡 

 

 
 

16) 点击 Equilibration 进入层析柱再平衡阶段设置，此阶段目的是将层析

柱中的缓冲液置换为适当的平衡或保存缓冲液。设置再平衡时缓冲液

的流速、进口、洗脱体积，也可以设置监视平衡 

 

 
 

17) Scouting 功能可以实现方便快速的条件摸索，点击工具栏上 Scouting

按钮 

 

 
 

选定需要探索的参数，点击 OK 
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点击 Insert Run 添加实验，输入各变量的参数值，点击 OK 确认，系

统将会按照设定的参数进行多次运行 

 

 
 

18) 选择工具栏中的 Start Protocol 

 

 
 

选择需要检查的方法项目，方法开始运行前将会提示对这些项目进行

确认，然后才开始运行 
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19) 完成所有设置后点击工具栏中的保存按钮 

 

 
 

选择保存的路径，输入方法名称后 Save 

 

 
 

20) 如要运行已创建的方法，在 System Control窗口 Method navigator中

选择方法，右键点击 Run   
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在跳出的 Start Protocol中确认设置的项目，点击 Start开始运行 

 

 
 

2.5 结果分析 

2.5.1打开结果 

1) 点击任务栏中的 Evaluation，进入结果处理窗口 

 

 
 

如果任务栏中没有 Evaluation窗口，可以在任意已打开的 UNICORN 6

窗口中点击 Tools，选择 Evaluation打开 
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2) 在 Evaluation窗口中点击 Open Results Navigator打开 Results文件导

航窗口 

 

 
 

双击待分析的结果文件打开 
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也可以在 Evaluation窗口中点击 File > Open > Chromatograms打开结

果选择窗口  

 

 
 

在弹出的窗口中双击待分析的结果，勾选 Chrom 1，点击向右双箭头

选中结果后按 OK键打开 

 

 
 

还可以通过单击“最近的运行(Recent Runs)”选项，找到需要分析的层

析结果双击打开 
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2.5.2层析结果的显示设置 

1) 正常打开的结果如下 

 

 
 

2) 在 Curve窗格点击鼠标右键，点击菜单中的 Customize 

 

 
 

在复选框中选中需要显示的色谱曲线 
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点击 OK即可使图谱简化，或者显示更丰富的曲线 

 

 
 

3) 如需对色谱曲线颜色及线型进行更改，点击 Curve Style and Color，

就可以对色谱曲线的属相进行编辑 

 

 
 

4) 如需对 Y 轴显示区间进行更改，点击 Y-Axis 选项卡。在左侧 Select 

curve to modify axis scale for 对话框中选中需要更改的曲线，点击

Fixed，并在对话框中填入 Min 和 Max 值；如需在色谱曲线右侧也显

示另外一条色谱曲线的 Y 轴左边，在 Right 下拉菜单中选中所定义的

曲线。点击 Ok即完成曲线显示区间自定义 
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自定义曲线以及显示结果如下图 

 

 
 

5) 如果需要对 X 轴显示类型和显示范围进行自定义，点击 X-Axis 选项

卡。选择 X 轴类型为 Time、Volumn 或 Column Volumn，如需固定 X

轴显示区间，在 Axis scale复选框中选定 Fixed并填写 Min和 Max数

值；如果需要在上样后 X轴自动归零，则需要在 Adjust retention zero 

to injection number复选框中打钩 
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6) 框选 Curve 窗格中的区域可以放大选中的部分，当需要将放大部分恢

复到原大小时，点击右键后选择 Undo Zoom或 Reset Zoom 

 

 
 

2.5.3显示 Vertical marker及显示设置参考点 

 

1) 在 Curve 窗格中点击鼠标右键，在悬浮菜单中左键点击 Vertical 

marker 以显示垂直游标线，拖动 Vertical marker 将显示与曲线交点

的坐标 

 

 
 

2) 如果需要计算曲线上两点之间的距离，可以通过设置参考点来实现，

在 Curve窗格中标记 Vertical marker后，点击鼠标右键，在悬浮菜单

中选择 Set vertical marker reference point 

 

 



51 
 

3) 拖动鼠标移动 Vertical marker到需要对比的位置，显示框中将显示这

两点之间的距离，这两点之间曲线的最大值、最小值以及平均值 

 

 
 

4) 为了方便比较，可以点击鼠标右键，在悬浮菜单中选择 Grid 功能，

Curve窗格中出现横竖参考线 

 

 
 

2.5.4更改横坐标显示类型 

Curve 窗格中点击鼠标右键，在悬浮菜单中选择 Time，Volume 或者

Column Volume为横坐标显示类型 
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2.5.5结果积分处理 

1) Curve窗格中点击右键，选择 Customize 

 

 
 

2) 勾选复选框去掉不需要显示的曲线 

 

 
 

3) 在工具栏中点击峰积分按钮，进行积分处理 

 

 
 

或者在 Integrate下拉菜单中点击 Peak Intergrate进行积分处理 
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4) 选择需要积分的曲线以及积分表存储位置，基线类型默认为

Calculate baseline 
 

 
 

5) 在积分窗口中点击 Peak Window 

 

 
 

出现以下窗口，通过拖动左右两条直线可以选择需要进行积分的范围，

点击 OK确认 
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6) 在积分窗口点击 Reject Peaks对需要分析的色谱峰可进行高级定义，

包括最小峰高、峰宽、峰面积、峰个数等，在这里最常用的是在

Peak area is less than输入需要显示的最大峰的个数，点击 OK确定 

 

 
 

7) 在 Column height (bed height)一栏中输入柱床高度，在柱效测定中此

项必须填写 
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8) 点击积分窗口中 Save and Edit Peak Table按钮，可以对峰进行高级操

作 

 

 
 

在弹出的编辑窗口中右键，选择相应的命令可以对峰进行填充图案、

删除、分割、合并以及命名等操作，编辑后按 OK确认 

 

 
 

9) 点击积分窗口中的 OK，查看积分结果 
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10) 如果默认基线不理想，可以对基线进行调节，点击菜单栏中

Integrate按钮，选择 Edit Baseline 

 

 
 

在适当的位置点击左键设置新的基线参考点并拖动，直至基线到达合

适的位置，点击 OK确认 

 

 
  

将调整后的基线保存到合适的位置，设置新基线的名称，点击 OK 确

认 
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设置新的基线后需要对色谱曲线重新积分，在 Baseline 下拉菜单中选

中新基线，点击 OK进行积分 

 

 
 

积分结果如下图显示，Peak data中默认显示保留时间、面积和高度 

 

 



58 
 

11) 如果需要查看更多的数据，可以在 Peak data 区域点击右键，选择

Customize 
 

 
 

在 Select peak table columns 对话框中找到需要显示的数据，如

percent of total peak area、plate height（HETP）、Asymmetry等，

如需对峰用阴影填充，选择 Fill peaks 复选框，并选择填充阴影类型

和颜色（Color），点击 OK执行 

 

 
 

Peak data区域中将会显示增选的分析结果 

 

 
 

2.5.6生成层析报告 

 

1) 如果想将层析结果以报告的形式打印或输出出来，请在工具栏中点击 

报告按钮 

 

 
 



59 
 

2) 选择合适的报告模板，单击 Preview 

 

 
 

也可以点击 Edit，在弹出的自定义窗口中通过工具栏中的功能按钮，

编辑文字、图片、图谱以及层析数据 

 

 
 

3) 将显示的报告打印出来即可，点击右边的 Exit退出报告模式 

 

 
 

2.5.7结果比对 

 

2.5.7.1色谱曲线叠加比对 

1) 首先打开一个层析结果，通过编辑使其只显示待比较的曲线 
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2) 需要与其他色谱图曲线进行叠加对比时，在 File 下拉菜单中选中

Open to Compare，点击 Curves 

 

 
 

3) 在弹出的对话框中点击 Browse 寻找需要比对的结果，选择曲线显示

方式，点击 OK完成色谱图曲线比对 
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结果如图 

 

 
 

2.5.7.2色谱结果比对 

1) 首先打开一个层析结果，如下图 

 

 
 

2) 在 File下拉菜单中选中 Open to Compare，点击 Chromatograms 
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3) 点击 Browse寻找需要比对的色谱图 

 

 
 

点击 OK打开第二色谱图，两图并列显示在不同的显示卡界面中 

 

 
 

4) 点击命令栏中的 View > Tile All Chromatograms 

 

 
 

两图谱将同时显示出来 
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2.5.8结果注释 

 

1) 如需在结果中添加文字注释，在 Curve 窗格中点击右键，选择 Add 

text 
 

 
 

2) 在目标位置点击左键，在出现的框中输入文字注释即可 

 

 
 

2.5.9结果分析  

2.5.9.1色谱曲线相加 

1) 如需要将两条色谱曲线叠加，点击菜单栏中 File > Open > 

Chromatograms，将其中一个色谱图打开 
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2) 点击菜单栏中 File > Open to Compare > Curves打开待叠加的第二条

曲线 

 

 
 

3) 点击菜单栏中 Operations > Add 
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4) 出现以下对话框后，在左边和中间 Source chromatogram and curve

框中分别选中两条需要叠加的曲线，输入叠加后曲线的名称选择存储

位置，单击 OK 

 

 
 

5) 图中将出现叠加后的曲线，叠加曲线的后缀为 ADD 

 

 
 

2.5.9.2色谱曲线相减 

1) 如果有一些假峰来源于洗脱液中的杂质，可以通过减去空白运行曲线

方式消除假峰，先将两条曲线打开，点击 Operation >  Subtract 

 

 



66 
 

2) 出现以下对话框后，在 Source chromatogram and curve框中分别选

中两条需要相减的曲线，输入相减后曲线的名称选择存储位置，单击

OK 
 

 
 

3) 曲线相减后将出现相减后的另一条曲线，相减后得到的曲线的后缀为

Sub 
 

 
 

2.5.9.3色谱曲线相除 

1) 物质在不同波长下的吸光度比值往往可以作为鉴别物质的一种方法，

UNICORN 中可以通过两条曲线相除来实现这一功能，先将两条曲线

打开，点击 Operation > Divide 
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2) 出现以下对话框后，在 Source chromatogram and curve框中分别选

中两条需要相除的曲线，输入相除后的曲线名称，选择存储位置序号，

单击 OK 

 

 
 

3) 相除后得到的曲线的后缀为 DIV 

 

 
 

2.5.9.4 曲线平滑功能 

1) 有时候色谱曲线中带有噪音，噪音可由几种原因引起，例如流动池脏

了、空气泡、电子噪音、缓冲液不干净等等。如需对色谱图进行去除

噪音处理，消除一些小杂峰，可点击 Operation > Smooth 
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2) 出现以下对话框后在左边的 Source chromatogram and curve对话框

中选中需要处理的曲线，然后在 Filter type 下选中平滑处理的方式，

拖动 Light与 Hard之间的滑块选择一个合适的平滑度，单击 OK 

 

 
 

3) 曲线平滑性处理后将得到另一条新曲线，新曲线的后缀为 SMTH 

 

 
 

2.5.9.5 曲线平移 

 

1) 在曲线比较时经常会遇到将某条曲线左右或上下移动，选择

Operations > Shift 
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2) 在 Source chromatogram and curve 栏中选择需要移动的曲线，在

Shift retention或 Shift amplitude复选框中打钩选择左右或上下移动，

填入需要移动的数值，点击 OK 

 

 
 

3) 曲线移动处理后将得到另一条新曲线，移动后的曲线会出现 SHFT 的

后缀 
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2.5.9.6曲线斜率计算 

1) 如需要了解色谱曲线的斜率值，可以通过对曲线进行一阶求导来实现。

在打开色谱图的情况下，选择 Operations > Differentiate 

 

 
 

2) 在 Source chromatogram and curve栏中选择需要求导的曲线，并选

择一阶求导（First order），点击 OK 

 

 
 

3) 色谱图中将出现一阶求导的曲线，曲线后缀为 dt，该曲线上的数值即

为对应曲线的斜率（Slope） 
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2.5.9.7活性直方图 

1) 如需将蛋白活性分析的结果数据（例如 ELISA）与 UV 曲线中峰进行

对照，点击 Operations > Activity Histogram 

 

 
 

2) 出现以下对话框，需要将每管的活性值输入到相对应的活性（Activity）

对话框中，点击 ok 

 

 
 

3) 色谱图中将出现一条蛋白活性的直方图曲线，曲线后缀为 HIST 
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2.5.9.8收集组分中的浓度计算 

1) 在分离过程中，组分是按顺序收集的，首先需要将每个峰的不同收集

管合并到一起，点击 Operations > Pool Fractions 

 

 
 

2) 选择源曲线以及待合并的组分，点击 OK 

 

 
 

3) 点击 Operations > Fraction Histogram 
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4) 在弹出的窗口中选中待处理的曲线和收集曲线，在 Path length 栏中

输入紫外检测池的光径，并在 Ext. coef. 栏输入组分的消光系数，此

时 Conc.栏将会显示合并组分的蛋白浓度，Amount 栏将显示合并蛋

白的总量 

 

 
 

2.5.9.9剪切曲线 

1) 如只需保留色谱曲线的一部分，在打开色谱图的情况下点击

Operations >  Cut Curve 
 

 
 

2) 选择待处理的曲线，点击 OK 
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3) 用鼠标拖动左右两边的垂线限定剪切范围，点击 OK 

 

 
 

4) 选择剪切后的曲线保存位置 
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5) 点击 OK保存 

 

 
 

2.5.10结果导出 

1) 如需将分析结果的图片从软件中导出到 Office 中，在曲线窗口中点击

右键，选择 Copy to Clipboard 

 

 
 

在 Office 文档或图片编辑软件中执行粘贴命令就可以将曲线复制到相

应的文档中 

 

2) 如需将分析结果以图片形式导出，可在曲线窗口中点击右键，选择

Copy to Metafile 
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选择图片存储路径以及图片格式进行保存 

 

 
 

3) 如需将色谱图以原始数据形式导出，在 File 下拉菜单中选择 Export > 

To UNICORN > Entire Result 
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选择保存的位置，点击 Save执行 

 

 
 

4) 如只需导出色谱结果中的部分曲线数据，可在 File 下拉菜单中选择

Export > To UNICORN > Curves 
 

 
 

在弹出的窗口中选择需要导出的数据，点击 Select 
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再次勾选要导出的曲线，点击 Export 

 

 
 

选择数据存储路径、文件名，点击 Save导出 
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3. 实验操作 

3.1   使用脱盐柱进行蛋白缓冲液的置换 

3.1.1实验目的 

 使用脱盐柱对细胞破碎后的表达上清液进行缓冲液置换，使样品能更有

效地结合在离子交换柱上 

 学习使用手动命令进行实验 

 

3.1.2实验材料  

 层析柱：5 ml Hitrap desalting column 2根 

 缓冲液:  20 mM Tris-HCl, pH 8.0 

 其余溶液：去离子水；20% 乙醇水溶液 （v：v） 

 实验耗材：5 ml 注射器，2 ml 样品环， 15 ml 离心管 

 待分离蛋白样品：大肠杆菌表达的带 6 X His 标签的重组绿色荧光蛋白

GFP (His-GFP)， 经 0.22 µm 针头滤器过滤 

 

3.1.3实验准备 

3.1.3.1开机 

1) 先打开 ÄKTApure电源，控制面板上的 power灯稳定不再闪烁时，打

开电脑，双击打开 UNICORN 6软件 

 

 
 

 

2) 点击 OK进入软件，打开系统控制 （System Control）窗口 
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3.1.3.2泵冲洗 

1) 将缓冲液管 A1 插入到 20 mM Tris-HCl, pH 8.0缓冲液中，在 System 

Control 窗口选择 Manual > Execute Manual Instructions 

 

 
 

2) 在跳出的在 Manual instruction窗口中选择 Pumps >Pump A wash，选

择 Inlet为 A1， 点击 Execute，进行泵冲洗 

 

 
 

3.1.3.3安装柱子 

1) 在 Manual instruction窗口中，选择 Flow path > Column position , 按

连接需要选择柱位，例如选择 Position 2，选择溶液流向为 Down flow，

点击 Insert 
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2) 在 Manual instruction窗口中，选择 Pumps > System flow, 设置 Flow 

rate 为 0.5-1 ml/min，点击 Insert 

 

 
 

3) 在 Manual instruction 窗口中，选择 Alarms > Alarm pre column 

pressure，设置  High alarm 为  0.3 MPa，点击 Insert，然后点击

Execute执行 

 

 
 

4) 在柱位阀 2A口连接上一根 PEEK连接管 

 

5) 待连接管的出口有持续的液体流出且无气泡的情况下，除去层析柱的

上堵头，将层析柱柱头与连接管出口相连，但不要拧紧 
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6) 除去层析柱下堵头，待层析柱出口有持续的液体流出，且无气泡的情

况下，将层析柱出口连接到柱位阀的 2B口上 

 

7) 拧紧上接头，将流速调整为 5 ml/min，对层析柱进行平衡至少 5个柱

体积 

 

8) 平衡完毕后，单击 Pause 暂停 

 

 
 

3.1.3.4样品环的安装与清洗 

在上样阀的 LoopF与 LoopE口连接上 2 ml 的样品环，用注射器抽取缓冲

液, 连接到上样阀的 Syr口上，推入缓冲液以清洗样品环，可重复几次 

 

3.1.3.5上样 

用注射器吸取约 2.5 ml的样品， 排除气泡后，连接到上样阀的 Syr口上，

将注射器内的样品推入，并将注射器保留在上样阀上 

 

3.1.4准备收集器 

在收集器内按顺序放入一定数量的 15 ml 收集管，调整悬臂到 1号位 

 

3.1.5运行实验 

1) 在 Manual instruction窗口中，选择 Flow path > Injection valve，上样

阀选择为 Inject 状态，点击 Insert 
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2) 在 Manual instruction窗口中，选择 Flow path > Outlet valve，选择出

口阀位为 Frac 

 

 
 

3) 在 Manual instruction窗口中，选择 Fraction collection > Fractionation，

设置 Fraction size 为 2 ml，点击 Insert 

 

 
 

4) 在 Manual instruction窗口中，选择 Pumps > System flow, 设置 Flow 

rate 为 5 ml/min，点击 Insert 

 

 
 

5) 在 Manual instruction窗口中，点击 Save result as 后面的 Browse 
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6) 在弹出的对话框中选择结果存储位置，输入文件名，点击 OK   

 

 
 

7) 点击 Execute执行上述命令 

 

 
 

8) 约 3 min后，待紫外与电导峰均出现后，点击工具栏中的 End，停止

实验 
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3.1.6结果分析与讨论 

1) 切换到 Evaluation 窗口中，选择保存的结果并打开 

 

 
 

2) 现场讨论： 

 紫外与电导峰分别代表什么？ 

 哪些收集管中包含样品？ 

 

3.1.7清洗与储存 

程序运行结束后需要手动清洗系统和层析柱并保存将二者保存在 20%乙

醇中。 

1) 将缓冲液 A1 的入口放入经脱气的去离子水中，进行泵清洗（见

2.2.3），待泵清洗结束后，用去离子水清洗柱子：在 Manual 

instruction窗口中，选择 Pump > System flow，设置 Flow rate 为 5 

ml/min，点击 Insert 

 

 
 

2) 在 Manual instruction 窗口中，选择 Alarms > Alarm pre column 

pressure，设置 High alarm 为 0.3 MPa，点击 Insert，然后点 Execute 
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3) 在 Manual instruction窗口中，选择 Flow path > Column position，选

择 Position 2，选择溶液流向为 Down flow，点击 Execute 

 

 
 

4) 运行 5倍柱体积后，暂停 

 

5) 将缓冲液 A1 的入口放入经脱气的 20% 乙醇水溶液中，进行泵清洗 

（见 2.2.3） 

 

6) 待泵冲洗结束后，机器会自动继续之前 5 ml/min 的流速，用 20% 乙

醇水溶液清洗柱子 

 

7) 待运行 5倍柱体积后，先拧松柱子上接头，将下接头从柱位阀上拧下，

并拧上柱子的下堵头 

 

8) 拧下柱子上面的接头并拧上柱子的上堵头 

 

9)  在 System Control界面命令栏中点击 End， 结束清洗 
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10) 在任一 UNICORN 6软件窗口中点击 File > Exit UNICORN退出软件 

 

 
 

11) 关闭 ÄKTApure电源 

 

3.2   离子交换层析实验 

3.2.1实验目的 

 使用阴离子交换实现蛋白的分离纯化 

 学会使用 Method Editor进行实验方法的编程 

 学会使用 Scouting功能进行层析柱的筛选 

 

3.2.2实验材料 

 层析柱： Hitrap Capto Q 1 ml，Hitrap Q FF 1 ml，Hitrap DEAE FF 1 ml 

 缓冲液 A:  20 mM Tris, pH 8.0 

 缓冲液 B:  20 mM Tris, 1 M NaCl, pH 8.0 

 其余溶液：去离子水；20% 乙醇水溶液 （v：v） 

 实验耗材：5 ml 注射器，5 ml 样品环，15 ml 离心管 

 待分离蛋白样品：经过缓冲液置换后表达有 His-GFP 的大肠杆菌发酵液

样品  

 

3.2.3实验准备 

3.2.3.1开机 

1) 先打开 ÄKTApure电源，控制面板上的 power灯稳定不再闪烁时，打

开电脑，双击打开 UNICORN 6软件 
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2) 点击 OK进入软件，打开系统控制 （System Control）窗口 

 

 
 

3.2.3.2泵冲洗 

1) 将缓冲液管 A1 插入到缓冲液 A 中，将缓冲液管 B1 插入到缓冲液 B

中，在 UNICORN 6软件的 System Control 界面选择 Manual > Execute 

manual Instructions 
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2) 在跳出的 Manual instructions窗口中，选择 Pumps > Pump A wash， 

选择 Inlet为 A1，点击 Insert；再选择 Pumps > Pump B wash， 选择

Inlet为 B1，点击 Insert，选择 Execute进行泵冲洗 

 

 
 

3.2.3.3安装柱子 

1) 在 Manual instruction 窗口中，选择 Alarms > Alarm pre column 

pressure，设置 High alarm 为 0.3 MPa，点击 Insert，然后点 Execute 

 

 
 

2) 在 Manual instructions窗口中，选择 Flow path > Column position , 按

连接需要选择柱位, 如选择 Position 1,  点击 Insert 
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3) 在 Manual instruction窗口中，选择 Pumps > System flow, 设置 Flow 

rate 为 0.5-1 ml/min，点击 Insert并执行 

 

 
 

4) 在柱位阀 1A口连接上一根 PEEK连接管 

 

5) 待连接管的出口有持续的液体流出且无气泡的情况下，除去层析柱的

上堵头，将层析柱柱头与连接管出口相连，但不要拧紧 

 

6) 除去层析柱下堵头，待层析柱出口有持续的液体流出，且无气泡的情

况下，将层析柱出口连接到柱位阀的 1B口上 

 

7) 拧紧上接头，单击 Pause 暂停 

 

 
 

8) 重复执行步骤 2)-7)，在柱位阀 2 号位、3号位上连接好另外两根层析

柱 

 

3.2.3.4 样品环的安装与清洗 

 

在上样阀的 LoopF与 LoopE口连接上 5 ml 的样品环，用注射器抽取缓冲

液，连接到上样阀的 Syr口上，推入缓冲液以清洗样品环，可重复几次 

 

3.2.3.5上样 

用注射器吸取稍大于 5 ml 的样品， 排除气泡后，连接到样品阀的 Syr

口上，将注射器内的样品推入，并将注射器保留在样品阀上 
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3.2.3.6收集器准备 

在收集器内按顺序放入一定数量的 15 ml 离心管，调整悬臂到 1号位 

 

3.2.4方法编辑 

 

1) 打开 UNICORN 6软件的 Method Editor窗口，点击命令栏中的 Create 

a new method图标 

 

 
 

2) 在跳出的 New Method 对话框中 Predefined Method 下选择 Anion 

Exchange Chromatography (AIEX)，点击 OK 

 

 
 

进入方法编辑界面 
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3) 在 Method Settings编辑界面中，选择 Result name & Location设置结

果名称及存贮位置 

 

 
 

选择 Column type 为 Any，Column volume 为 1 ml，Pressure limit 

pre-column 为 0.3 MPa，Column position为 1，Flow rate 1 ml/min，

激活紫外检测 UV2，设置为 395 nm 

 

 
 

4) 点击 Equilibration 进入平衡阶段设置，平衡流速、缓冲液入口不变，

平衡时缓冲液 B所占的比例为 0%，输入平衡体积 5 CV 
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5) 点击 Sample Application 进入上样阶段设置，仍然使用方法设置流速

1 ml/min，选择上样的方式为 Manual load，Loop type 为 Capillary 

loop，输入清空样品环的体积 1.5 ml 

 

 
 

6) 点击 Column Wash进入柱冲洗阶段设置，选择冲洗使用 B液浓度 0%，

冲洗的溶液体积为 3 CV 

 

 
 

7) 点击 Elution 进入洗脱设置，保持洗脱流速、缓冲液入口以及缓冲液

流向不变 
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8) 设置使用线性洗脱，在 15 CV之内 B浓度升至 100%，采用收集器进

行固定体积收集，每管收集 1 ml 

 

 
 

9) 点击 Column Wash 进入下一步柱冲洗阶段设置，此阶段目的是对层

析柱进行再生。设置再生缓冲液为 100% B，启用 Watch功能，选择

the following condition is met为 Stable UV，参数设置为 1 min内 UV

变化小于 0.1 mAU，最大冲洗体积为 5 CV 

 

 
 

10) 点击 Equilibration 进入层析柱再平衡阶段设置，此阶段目的是将层析

柱中的缓冲液置换为平衡缓冲液。设置平衡体积为 5 CV 



95 
 

 
 

11) 点击工具栏上 Scouting按钮，进行层析柱筛选设置 

 

 
 

选定需要探索的参数为 Column position，点击 OK 

 

 
 

点击 Insert Run，添加两次实验，在 Method Setting 中 Column position

一栏中选择三次实验采用的柱位分别为 1、2、3号位，点击 OK确认 
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12) 点击工具栏上保存按钮 

 

 
 

在弹出的窗口中选择存储位置，输入方法名称，点击 Save保存 

 

 
 

3.2.5 运行实验 

1) 重新切换到 System Control 窗口，在 Method Navigator窗口中双击已

保存的方法 AIEX demo 
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2) 在跳出的对话框中再次确认结果保存的位置及结果名称，点击 Start

开始运行 

 

 
 

3) 实验一直按照程序运行，并自动结束 

 

3.2.6结果分析与讨论 

1) 切换到 Evaluation 窗口中，选择保存的结果并打开 

 

 
 

2) 现场讨论： 

 目标蛋白在什么盐浓度下被洗脱？ 

 如何对实验进行优化？ 
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3.2.7清洗与储存 

程序运行结束后需要手动清洗并保存系统和层析柱 

 

1) 将缓冲液 A1， B1 的入口放入经脱气的去离子水中，分别进行泵清洗

（见 2.2.3） 

 

2) 待泵清洗结束后，用去离子水清洗柱子：在 Manual instruction 窗口

中，选择 Pump > System flow，设置 Flow rate 为 3 ml/min, 点击

Insert 
 

 
 

3) 在 Manual instruction 窗口中，选择 Alarms > Alarm pre column 

pressure，设置 High alarm 为 0.3 MPa，点击 Insert，然后点 Execute 

 

 
 

4) 在 Manual instruction窗口中，选择 Flow path > Column position，选

择 Position 1，选择溶液流向为 Down flow，点击 Execute 
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5) 运行 5倍柱体积后，暂停 

 

6) 将缓冲液 A1 的入口放入经脱气的 20% 乙醇水溶液中，进行泵清洗 

（见 2.2.3） 

 

7) 待泵冲洗结束后，机器会自动继续之前 3 ml/min 的流速，用 20% 乙

醇水溶液清洗柱子 

 

8) 待运行 5倍柱体积后，先拧松柱子上接头，将下接头从柱位阀上拧下，

并拧上柱子的下堵头 

 

9) 拧下柱子上面的接头并拧上柱子的上堵头 

 

10) 重复步骤 4)-9)，将柱位分别选择为 2、3 号位，冲洗另外两根层析柱

后将柱子保存起来 

 

11)  在 System Control界面命令栏中点击 End， 结束清洗 

 

 
 

12) 在任一 UNICORN 6软件窗口中点击 File > Exit UNICORN退出软件 
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13) 关闭 ÄKTApure电源 

 

3.3 应用亲和层析纯化 His 标签蛋白 

3.3.1实验目的 

 对大肠杆菌表达的 His-GFP上清进行亲和纯化 

 学会使用 Method Editor 进行亲和实验程序的编程 

 通过编程对层析柱进行在位清洗（CIP） 

 

3.3.2实验材料  

 层析柱： HisTrap excel 1 ml column 

 缓冲液 A:  20 mM Tris, 300 mM NaCl,  pH 8.0 

 缓冲液 B:  20 mM Tris, 300 mM NaCl, 500 mM 咪唑, pH 8.0 

 其余溶液：去离子水；0.1 M NaOH；20% 乙醇水溶液 （v：v） 

 实验耗材：5 ml 注射器，2 ml 样品环，15 ml  离心管 

 待分离蛋白样品：大肠杆菌表达的 6X His 标签重组绿色荧光蛋白 GFP

的预处理样品  

 

3.3.3实验准备 

3.3.3.1开机 

1) 先打开 ÄKTApure电源，控制面板上的 power灯稳定不再闪烁时，打

开电脑，双击打开 UNICORN 6软件 

 

 
 

2) 点击 OK进入软件，打开系统控制 （System Control）窗口 
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3.3.3.2泵冲洗 

1) 将缓冲液管 A1 插入到缓冲液 A中，A2插入去离子水中，A3插入 0.1 

M NaOH 中，A4 插入 20%乙醇中，B1 插入到缓冲液 B 中，在

UNICORN 6软件的 System Control 界面选择 Manual > Execute manual 

Instructions 
 

 
 

2) 在跳出的 Manual instructions窗口中，选择 Pumps > Pump A wash， 

选择 Inlet 为 A1，点击 Insert，并重复插入 A2、A3、A4 泵洗；再选

择 Pumps > Pump B wash， 选择 Inlet 为 B1，点击 Insert，选择 

Execute执行 
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3.3.3.3安装柱子 

1) 在 Manual instruction 窗口中，选择 Alarms > Alarm pre column 

pressure，设置 High alarm 为 0.3 MPa，点击 Execute 

 

 
 

2) 在 Manual instructions窗口中，选择 Flow path > Column position , 按

连接需要选择柱位, 如选择 Position 1,  点击 Insert 

 

 
 

3) 在 Manual instruction窗口中，选择 Pumps > System flow, 设置 Flow 

rate 为 0.5-1 ml/min，点击 Insert并执行 

 

 
 

4) 在柱位阀 1A口连接上一根 PEEK连接管 

 



103 
 

5) 待连接管的出口有持续的液体流出且无气泡的情况下，除去层析柱的

上堵头，将层析柱柱头与连接管出口相连，但不要拧紧 

 

6) 除去层析柱下堵头，待层析柱出口有持续的液体流出，且无气泡的情

况下，将层析柱出口连接到柱位阀的 1B口上 

 

7) 拧紧上接头，单击 Pause 暂停 

 

 
 

3.3.3.4 样品环的安装与清洗 

在上样阀的 LoopF与 LoopE口连接上 2 ml 的样品环，用注射器抽取缓冲

液，连接到上样阀的 Syr口上，推入缓冲液以清洗样品环，可重复几次 

 

3.3.3.5上样 

用注射器吸取稍大于 2 ml 的样品， 排除气泡后，连接到样品阀的 Syr

口上，将注射器内的样品推入，并将注射器保留在样品阀上 

 

3.3.3.6收集器准备 

在收集器内按顺序放入一定数量的 15 ml 离心管，调整悬臂到 1号位 

 

3.3.4方法编辑 

1) 打开 UNICORN 6软件的 Method Editor窗口，点击命令栏中的 Create 

a new method图标 

 

 
 

2) 在跳出的 New Method 对话框中 Predefined Method 下选择 Affinity 

Chromatography (AC)，点击 OK 
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3) 进入方法编辑界面 

 

 
 

4) 首先编辑实验阶段，由于实验后要对层析柱进行在位清洗，在

Predefined Phases中找到 Column CIP模块并拖动 Elution阶段后 
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5) 在 Method Settings编辑界面中，选择 Result name & Location设置结

果名称及存贮位置 

 

 
 

选择 Column type 为 Any，Column volume 为 1 ml，Pressure limit 

pre-column 为 0.3 MPa，Column position为 1，Flow rate 1 ml/min，

激活紫外检测 UV2，设置为 395 nm 

 

 
 

6) 点击 Equilibration 进入平衡阶段设置，平衡流速、缓冲液入口不变，

平衡时缓冲液 B所占的比例为 0%，输入平衡体积 5 CV 
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7) 点击 Sample Application 进入上样阶段设置，仍然使用方法设置流速

1 ml/min，选择上样的方式为 Manual load，Loop type 为 Capillary 

loop，输入清空样品环的体积 4 ml 

 

 
 

8) 点击 Column Wash进入柱冲洗阶段设置，选择冲洗使用 B液浓度 0%，

冲洗的溶液体积为 3 CV 

 

 
 

9) 点击 Elution 进入洗脱设置，保持洗脱流速、缓冲液入口不变，选择

缓冲液流向为 Up flow，反向洗脱有利于得到高浓度的样品 

 

 
 

设置使用三步阶段洗脱，首先使用 10% B洗脱 5 CV，第二步使用 60% 

B洗脱 5 CV，第三步使用 100% B洗脱 5 CV，采用收集器进行固定体

积收集，每管收集 1 ml 
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10) 点击 Column CIP 进入层析柱再生阶段设置，此阶段目的是使用

NaOH将层析柱上残留的顽固污染物清除 

 

 
 

通过点击 Add Step共设置 4步 CIP 

 

 
 

 第一步选用 A2 入口去离子水清洗层析柱，目的是替换掉柱子中

的缓冲液，为 NaOH清洗做准备 

 第二步选用 A3入口 0.1 M NaOH清洗层析柱，清除顽固污染物 
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 第三步选用 A1 入口 Tris 缓冲液替换掉 NaOH 溶液，这是因为如

果用水替换 NaOH很难快速使柱中溶液 pH降至中性 

 第四步选用 A2 入口去离子水清洗层析柱，目的是替换掉柱子中

的缓冲液 

 

11) 点击 Equilibration 进入层析柱再平衡阶段设置，此阶段目的是将层析

柱中的水置换为 20%乙醇保护液，选择 A缓冲液入口为 A4（20% 乙

醇），设置平衡体积为 5 CV 

 

 
 

12) 点击工具栏上保存按钮 

 

 
 

在弹出的窗口中选择存储位置，输入方法名称，点击 Save保存 
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3.3.5 运行实验 

1) 重新切换到 System Control 窗口，在 Method Navigator窗口中双击已

保存的方法 AC with CIP 

 

 
 

2) 在跳出的对话框中再次确认结果保存的位置及结果名称，点击 Start

开始运行 

 

 
 

3) 实验一直按照程序运行，并自动结束 

 

3.3.6结果分析与讨论 

1) 切换到 Evaluation 窗口中，选择保存的结果并打开 
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2) 现场讨论： 

 目标蛋白在什么咪唑浓度下被洗脱？ 

 如何进行峰积分？ 

 

3.3.7清洗与储存 

程序运行结束后需要手动清洗并保存系统和层析柱，层析柱中 

 

1) 将缓冲液 A1、A2、A3、A4、B1 的入口都放入经脱气的去离子水中，

分别进行泵清洗（见 2.2.3） 

 

2) 将缓冲液 A1、A2、A3、A4、B1 的入口都放入 20%乙醇中，分别进

行泵清洗（见 2.2.3） 

 

3) 在 Manual instruction窗口中，选择 Pump > System flow，设置 Flow 

rate 为 1 ml/min, 点击 Insert 
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4) 在 Manual instruction 窗口中，选择 Alarms > Alarm pre column 

pressure，设置 High alarm 为 0.3 MPa，点击 Insert，然后点 Execute 

 

 
 

5) 在 Manual instruction窗口中，选择 Flow path > Column position，选

择 Position 1，选择溶液流向为 Down flow，点击 Execute 

 

 
 

6) 待液体流出后，先拧松柱子上接头，将下接头从柱位阀上拧下，并拧

上柱子的下堵头 

 

7) 拧下柱子上面的接头并拧上柱子的上堵头 

 

8)  在 System Control界面命令栏中点击 End， 结束清洗 

 

 
 

9) 在任一 UNICORN 6软件窗口中点击 File > Exit UNICORN退出软件 
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10) 关闭 ÄKTApure电源 


